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The S-5200 login dialog window will open.

S5-5200

Scanning Electron Microscope

Copyright(C)1998-2001
Hitachi High-Technologies Corporation.
All rights reserved.

Fig. 2-14 $-5200 Login Dialog Window

At the first startup after installation of the program, use the log-in name [S-5200] and click the
OK button. You do not need Password.

After log-in names and passwords for them are set, input the name and the password and then,
click the OK button, ‘

NOTICE: 1. Setting and maintaining log-in names and passwords shall be done by the
system supervisor.
Refer to 2.3.26 Login Setting Dialog window and 3.11.18 Setting Login Name.
2. Setting or changing password for a log-in name once registered with above
operation can be made using the Password Setting dialog window.
Refer to 2.3.29 Password Setting Dialog Window and 3.11.17 Password Setting.
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2.3.2 S-5200 SEM Main Window

This window is the main

e Titiebar......ccocc.........

Minimize button :
Size button

Close button

e Menubar...............

e Toolbar....................

¢ Scanning Image

window.......c.c.ccouveeen.

window for operation.of the microscope.

Fig. 2-15 $-5200 Operation Window

Shows the window title _ '

Minimizes the window. The window is iconized and placed on the
Task bar.

The window status becomes Normal type. You can change the
window size. This button will be changed to Maximize button.
Terminates the S-5200 operation program and closes the window.

Click one of commands on the pull-down menu to execute the
command.

Frequently used commands are placed on the tool bar as tool buttons.
Click a button to execute the command.

The scanning image window displays a scanning image.
Control buttons for usual operation are placed on the window.
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2.3.3 Menu
The menu bar and the toolbar include the following menus and commands.
(1) FileMenu

The File. menu includes commands for opening and saving flles photo recording, and
image printing.

Open SEM Data Manager .Opens the SEM Data Manager wmdow
T Referto: 2.3.8 SEM Data Manager Wlndow
Dlrect Save..........',;,_,..-.-.....».v.,;.,..',‘;./Open§..‘the Save Image dialog window. -It is used-for saving
: viewing images to disk.”  (To save captured images, use the
Save button in the Captured Image window.)
- .. Referto:.-2.3.34 Save lmage Dlalog Window.
Operatlng Condltlon....;';‘.:~...,:..Opens the Operatlng Condition d|alog window. - 1t is used
for saving and loading’ operatlng conditions, such as
S accelerating voItage lens settlng and’ ahgnment data.
- “Reférto: 2.3.28 Operatmg Condltlon Dlalog Wlndow

D|rect Photo....;..’ ...... edeeiene Executes Direct Photo recordlng ,
= - -Referto: “3.6.7 (3) Dlrect Photo Recordmg
Memory Photo ..................... Executes Memory Photo Recording.
R "Reler lo: 3 8.7 (4) Memory Photo Recordlng
Video Printer....................... Prepares images for a video printer.. -
o - Referto: -3.11.10 Video Printer o
Print......... S S, 'Opens the Print Setup dialog Wmdow “Itis used for printing

viewing images on a Windows- supported printer. (To print
out images saved on disk, use the Print function in the SEM
Data Manager window.) :
o Refer to: 2.3.31 Print Setup Dialog Wlndow
EXit...oooieeeee e - Closes SEM operatlon

(2) Edit Menu

The Edit menu includes commands for copymg vnewmg lmages and attnbutes to the -
‘Windows clipboard.

Copy Image....;;...;' ........... .....Copies wewmg images to the Wmdows chpboard
'~ " "Referto: 3.11.12 Copy Image ~
Copy Attribute ......... reene.s..Copies |nformat|on of V|ewmg |mages to the Windows '
R ECE " clipboard. ' o

 'Refer to: 3.11.13 Copy Attribute




(3)

(4)
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Setup Menu '

The Setup menu includes commands for opemng setup dialog wmdows for operat:on of HV,
column and others: -

HV Control ........ P reeerans ...Opens the HV Control dialog window. It is used for applying
- accelerating voltage, flashing operation or setting emission
“current. '
" Referto: 2.3.24 HV Control Dialog Window
Column SetUp ..................... Opéens the Column SetUp dialog window. It is used to

select the optimal electron optical column conditions.
' Refer to: 2.3.16 Column SetUp Dialog Window
Image SetUp ... Opens the Image Setup dialog window. It is used for setting
’ ~ the preset magnifications, contrast and brightness of ABCC,
capture resolution, capturing speed and screen mode.
Refer to: 2.3.25 image Setup Dialog Window
Signal Select.................. ......0pens the Signal Select dialog window. ltis used for signal
‘ selection.
Refer to: 2.3.36 Signal Select Dialog Window
2.3.37 Signal Select (Color Mixing) Dialog Window

Photo Condition .................. Opens the Photo Condition dialog window. It is used for
selecting scanning speed and other photo recording
conditions.

Refer to: 2.3.30 Photo Condition Dialog Window
Data Display...........cccocoenees Opens the Data Display dialog window. It is used to turn

data display On/Off and select specific informalion to be
printed on image.
Refer to: 2.3.21 Data Display Dialog Window

Operate Menu

The Operate menu includes commands for operation of column alignment, raster rotation,
motorized stage, auto functions etc.

Simple Operation ................ Opens the Simple Operation toolbox. Frequently used
: © function buttons are placed on the tool box. When you feel

using buttons on the toolbar is confusing, open this tool box
and close the toolbar. "You can operate almost all functions
on this tool box. Also it is useful when using the Full Screen
mode upon closing the toolbar and controls on the Scanning
Image window to extend image area.
Refer to: 2.3.38 Simple Operation Dialog Window

Alignment............................ Opens the Alignment dialog window. It is used for column
alignment operation.
Refer to: 2.3.15 Alignment Dialog Window
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Raster Rotation ................... Opens the Raster Rotation dialog window. It is used for
image rotation, dynamic focusing and tilt compensation.
< : Refer to: 2.3.33 Raster Rotation Dialog Window
Stage Control....................... Opens the Stage Control dialog window. It is used for
monitoring stage coordinate.
. Referto: 2.3.40 Stage Control Dialog Window

ABCC...........ccccc.... cerrrreeren Executes automatic brightness and contrast control.
Refer to: 3.5.3 (1) Auto Adjustment (ABCC)
Auto Focus ............ccceeeeuueen. Executes automatic focusing.
. Referto: 3.5.4 (2) Auto Focus Function
Auto Stigma......................... Executes automatic-astigmatism correction.
Refer to: 3.5.4 (4) Auto Stigma Function
BC Monitor.........c.c.ccoeunnnee. Starts BC Monitor mode.
_ Refer to: - 3.5.3 (3) BC Monitor Mode
Focus Monitor ..................... Starts Focus Monitor mode.
A ‘ Refer to: 3.5.4 (6) Focus Monitor Mode
MagMode............ccoernnneee. Selects High Mag or Low Mag modes.

Refer to: 3.5.1 Selecting Magnification
(5) Scan Menu

The Scan menu includes commands for scanning control.

Run (Freeze) .................. ......Auns or Freezes scanning alternately.
Capture .........ccccoeeevvvvvvennnnnne Starts image capturing.
: , . Refer to: - 3.6.4 Image Capturing
Split Dual Mag ..................... Activates Split/Dual Mag mode.
: Refer to:  2.3.39 Split/Dual Mag Controller
Scan Speed..........c.cccceeene Selects scanning speed.

Refer to: 3.5.2 Selecting Scanning Speed
(6) Image Menu
The Image menu includes commands for signal or irhage processing.

Signal Process e Opens the.SignéI Processing dialog window.

_ Refer to: 2.3.35 Signal Processing Dialog Window
Pseudo Color....................... Opens the Pseudo Color dialog window. It is used for

coloring images. »
Refer to: 2.3.32 Pseudo Color Dialog Window



(7)

(8)

2.3.3

Color Mixing ......... rrereirenns ..Opens the Signal Select (Color Mixing) dialog window with
R ‘ Color Mixing setting area. It is used for color mixing of two
“images with different signal sources. This command is
available only in Dual Screen display mode.
‘ Referto: 2.3.37 Signal Select (Color Mixing) Dialog Window
DataEntry.................cccceeia. Opens the Data Entry toolbox. It is used for characters and
graphics overlay on images.
‘ Refer to: 2.3.22 Data Entry Toolbox
PCl Transfer......................... Transfers viewing images to the PCI window.
This command is available only when PCI software is installed.

’Ahalysis Menu

The Analysis menu includes commands for analysis modes, measurement and others.

Analysis Mode .................... Enables (On) or Disables (Off) analysis mode buttons on the
Scanning Image window.
Refer to: 3.11.4 X-ray Analysis Mode

Normal.............ccccoererriiinns Sets to Normal mode (image observation).
Line Analysis ....................... Selects Line analysis 1 and 2 mode alternately.
Refer to: 3.11.4 Line Analysis Mode
Spot Analysis....................... Selects Spot 1 and 2 mode alternately. -
Refer to: 3.11.4 Spot Analysis Mode
Area Analysis....................... Selects Area analysis 1 and 2 mode alternately.
Refer to:  3.11.4 Area Analysis
Oblique............ccovvrcvieerrnnnn. Opens Oblique Image window and displays bird’s-eye view

of viewing images.
‘ Refer to: 2.3.27 Oblique Dialog Window
CD Measurement................. If the CD-Measurement option is installed, the CD
Measurement dialog window is brought up. If the option is
not installed, measurement cursors appear on the image.

Option Menu
The Option menu includes commands for optional functions.

Environment Setting ........... Opens the Environment Setting dialog window. It is used
for Data Entry and CD-Measurement font selection, selection
of mouse control on the scanning image, and selection of
data transfer to PCI. >
Refer to: 2.3.23 Environment Setting Dialog Window

Login Setting ....................... Opens the Login Setting dialog window. It is used for
setting login names and passwords for users. The dialog
window can be opened only when logged in with the system
manager’s login name. ' '

Referto: 2.3.26 Login Setting Dialog Window .
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Toolbar Setting............ ........Opens the Toolbar Setting dialog window. Itis used for
- setting arrangement of tool buttons on the toolbar.
The.customized toolbar arrangement will be saved for each of

_current users. .
Refer to: 2.3.41 Toolbar Setting Dialog Window

Password Setting.............. ...Opens the Password Setting dialog window. - It is used for
setting or changing the password for the login name of the
" current user. .
Refer to: 2.3.29 Password Setting Dialog Window

- Comm Port Settmg .............. Opens the Comm Port Setting dialog window. Itis used for
‘setting data necessary for file transfer to and from a network
computer.
Refer to: 2.3.42 Transfer Setting Dialog Window .
Maintenance ................. .......Opens the Maintenance window. It is used for setting the

(9)

(10)

-, maintenance date of scroll pump.
Refer to: 4.4 Maintenance of Scroll Pump

Window Menu

The Wmdow menu mcludes commands for selecting a type of scanning lmage wmdow
opening the Captured Image window, and others. =

Screen Mode........................ Selects Screen Mode (Standard, Dual, or Full Screen).

Referto: 3.11.1 Screen Mode -
Scanlmage ... Selects the location of the Scanning Image window on the

CRT monitor (Left / Center / Right). And closes (disappear)
o’r Opens (appear) the Scanning Image window on the CRT
monitor (Close / Open).

‘Captured Image.................... Opens the Captured Image window.

R o ' " Refer to: 2.3.7 Captured Image Window

Close All..........coooovevvvvvmreeennns Closes all dialog windows except for the Scanning Image
window.

Back Color ...........................Sclects a background color of §-5200 main window from a list
of colors.

Toolbar............c..cccioviinnninn Displays or removes toolbar. It is.used for removing the

toolbar to expand image area in the Full Screen display mode.
Help Menu

Opens Help for $-5200 SEM 'op’erafion. .

INAEX. e, -......Shows the’ index of S-5200 Help.

Search Shows the key -word search of 5-5200 Help.
About FE-PC SEM ...... .........Indicates the version of $-5200 PC-SEM.
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2.3.4 Toolbar

You can select tool buttons placed on the toolbar. - The button arrangement is saved )
independently for each Iogrn name. You can use your own toolbar when logged in with your -
unique login name. -

Refer to: 3.11.16 Toolbar Settlng Dlalog W|ndow

SEM Data Manager ......... ..Opens the SEM Data Manager window. It operates the same
as File-Open SEM Data Manager command.

Direct Save......... verneeren. Opens the Save Image dialog window. It is used for savmg
o - viewing images to disk. It operates the same as File-Direct
Save command. s /
Print SetUp...........;....‘.‘ ..... Opens the Print Setup dialog window. It is used for printing N
S 'viewing images to a Windows-supported printer. It operates the
_ same as File-Print command. ‘
Column Setup........... .......Opens the Column SetUp dialog window. It is used to select
‘ ' - the optimal electron optical column conditions. It operates the
same as Setup-Column command.
Alignment..........ciciveeniens . Opens the Alignment dialog window. It is used for column
alignment operation. It operates the same as
 Operate-Alignment command. ' :
Image SetUp ........ccueeeeen. Opens the Image SetUp dialog window. 1t is used for selecting
preset magnification, contrast and brightness of ABCC, capture
resolution, capturing speed and screen mode. |t operates the.
_ - same- as Setup-Image command.
Photo Condition............. ..Opens the Photo Condition dialog window. It is used for
' - selecting scanning speed and other photo recording conditions.
. ~ It operates the same as Setup-Photo Condition command. "«
Data Display........coceenneee. Opens the Data Display dialog window. It is used to turn data
: o display On/Off and select specific information to be printed on
-~ image. It operates the same as Setup-Data Display command.
Simple Operation............. Opens the Simple Operation toolbox. Frequently used
© - “function buttons are placed on the tool box. When you feel
using buttons on the toolbar is confusing, open this tool box and
- close the toolbar. You can operate almost all functions on this
~ toolbox. ' It operates the same as Operate-Simple Operation

‘ . command.
Split Dual Mag............. .....Activates Split/Dual Mag mode. * It operates the same as
BRI : Scan-Split DM Mode command. ,
CD Measurement............ If the CD-Measurement option is installed, the CD Measurement

- dialog window is brought up. " If the option is not installed, -
“ measurement cursors appear on the image. It operates the
same as Analysis-Measure comimand.
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Signal Select .

Pseudo Color.

Color Mixing ..

Data Entry .....

: Copy Image...

Copy Attribute

Stage Control :

Standard Scréen Mode..

Raster Rotation ...............

Signal Process ................

..................

.Opens the Raster Rotation dialog window. It is used for image
rotation, dynamic focusing and tilt compensation. It operates
the same as Operate-Raster Rotation.command.

Opens the Stage Control dialog window. It is used for
monitoring stage coordinate. It operates the same as Operate-
Stage Control command. : : :
Opens the Signal Select dialog window. It is used for signal
selection. It operates the same as Setup-Signal Select E
command. B

Opens the Signal Process dialog window. It is used for signal
processing. [t operates the same as Image-Signal Process
command. ,
Opens the Pseudo Color dialog window. It is used for coloring
images. It operates the same as Image-Pseudo Color
command. :

Opens the Signal Select (Color Mixing) dialog window with -
Color Mixing setting area. It is used for color mixing of two

. images with different signal sources. This command is

Full Screen Mode.............

| Eriable Analysis Mode.....

Operatmg Condltlon.._...‘....

available only in Dual Screen display mode. It operates the
same as Image-Color Mixing command.

Opens the Data Entry toolbox. It is used for characters and
graphics overlay on images. It operates the same as
Image-Data Entry command.

..Selects Standard Screen display mode. |f screen mode is the

Standard, move Scanning image window to left, center and right
side of the main window alternatively. It operates the same as

: ‘Window-Screen Mode-Standard Screen command.
Dual Screen Mode...........

Selects Dual Screen display mode. It operates the same as
Window-Screen Mode-Dual Screen command. A
Selects Full Screen display mode. It operates the same as
Window-Screen Mode-Full Screen command. :
Analysis mode buttons are shown or erased on Scanning image
window alternately. It operates the same as Analysis-Analysis
Mode command.

Opens the Operating Condition dialog window. It is used for
saving and loading operating conditions, such as accelerating
voltage, lens setting and alignment data. It operates the same
as File-Operating Condition command. o
Copies the scanning image to the Windows cllpboard

It operates the same as Edit-Copy Image command.

Copies the information of scanning image to the Windows

. clipboard. It operates the same as Edit-Copy Attribute
. command.
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Opens the Oblique dialog window and displays-bird’s-eye views
of viewing images. |t operates the same as Analysis-Oblique
'Command . SRR IR
Opens the Captured lmage wmdow It operates as same as
Window-Captured Image command. : :
Transfers a selected image to the PCI window. (provided by
Quartz Imaging Co.) Auvailable only when PCI software is
installed. - It operates the same as Image-PCl Transfer
command.

Opens Heip for S-5200 SEM operation.

Sets the stage to specimen exchange position. It operates
same as Go to Home button on the Stage Control dialog
window. :

Applies high voltage to the eIectron gun and controls extraction
voltage to obtain the emission current. The voltage value to be
applied is indicated in the HV display area. The'button is

. changed to 1 when high voitage is apphed so the emission
current values can be adjusted

Shuts down the high voltage.

Displays accelyetating voltage, emission current and extracting
~ voltage. When accelerating voltage is on, these values are
~ displayed in yellow color. When acceleratmg voltage is off and
. the vacuum condition of the gun and the column is good, they
. are displayed in blue and flicker. '
The HV Control dlalog window can be opened by clicking this
area. : ~

10.5uAS.
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2.3.5 ,Scanning Image Window.

The scannlng image window (Standard screen mode) dlsplays a scanning |mage of 640 x 480
pixels. Most functions are available:in this-mode. : ; .
e Standard Screen mode: This mode displays a scanning image of 640 x 480 plxels

e Dual Screen mode : This mode displays two lmages using the same or different
co » signals. ~
¢ Full Screen mode :On this mode, the SEM image is enlarged to fill a full screen.

These windows have control buttons listed below

(1) Standard Screen Mode

Runs or Stops scanning alternately.

Starts image capturing.

Selects scanning speed Fast 1 or Fast 2 alternately.
Selects scanning speed Slow 1 or Slow 2 alternately.
Selects scanning speed Slow 3 or Slow 4 alternately.

Reduce 1/2 button: Selects scanning speed Reduce 1 or
Reduce 2 alternately.

Starts auto brightness/contrast adjustment (ABCC).
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Auto Focus....................... Starts auto focusing (AFC). - .-
Auto Stigma ....c..oviceceinnnnns Starts auto astigmatism correction (AST).
BC Mbnitor .................... ...Sets BC Monitor mode (for manual brightness and contrast
adjustment).
Focus Monitor .............. ....Sets Focus Monitor mode (for manual focusing).
Wobf)ler Cteresednenna feiivennennt Opené the Aligmb'rvler‘\t}dialog window.
Normali..v.w.v.......; ................. Sets Normél mode.
Line..;..............f ............ .... Selects Line analysis 1 or 2 mode alternately.
SPOt . Selects Spot 1 or Spot 2 mode alternately.
Area....cooeecieeiiiniteecee Selects Area analysis 1 or 2 mode alternately.
[ 2 C U Check this box whben acquifingl image using Digital Beam Control

function which permits the primary beam control from EDX
systems. ' : Lo

Area for magnification indication and operation.
Sets magnification at a preset value.
Selects High Mag-or Low Mag mode alternately.

Starts.adjustment, sets On/Off and indicates status of Beamn
Monitor. ‘

Direct Photo (Option) ....... Starts Direct Photo recording. .

Memary Phaoto (Option).... Starts Memory Photo recording. ..

Video Printer (Option} ...... Prepares images for a video printer.

................. «....... Indicates the current position of Electrical Image Shift.

Starts (or releases) image shift control with the mouse.

Resets Image Shift.
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Starts (or releases) stage operation with the mouse.
Starts (or releases) RISM operation with the mouse.

.. Opens the Stage Control d|alog window.

When this box is checked (ON) all controls for mouse operation,
such as focusing, brightness and contrast adjustment, and
astigmatism correction are enabled. When this box is not checked
(OFF), the controls selected in the Environment Setting dlalog
window are enabled.

Displays (or erases) the area marker.

Displays (or erases) scroll bars.

Brightness and
Contrast Sliders.........cooeeeee Slider controls for adjustment of brighlness and contrast.

v

Focus Sliders....ccccevvnrrernrnne Slider controls for focus (fine and coarse).

Displays Probe Current mode.
‘Displays resolution of captured image.

Displays the Specimen Holder Type which is set in the Restrlctlon
dialog window. -

Opens the Signal Control dialog window.

Opens the SE/BSE Detectors dialog window.

...Opens the Cell Countlng dialog window.

Refer to: 3.11.1 Screen Mode




(2)

Dual Screen Mode

Tesdesasncensnna

2.3.5

Runs or stops scanning of the A plane (left side image)
alternately. '

Runs or stops scanning of the B plane ('right side image)
alternately. Tl

Runs or stops scanning of both the A and B planes

simultaneously.

The Record A-or B button selects the A (left side) or B (right
side) screen image for the source of Direct Photographing,
Memory Photographing, Direct Saving, Copying to the
clipboard and Transferring to PCI.

Starts image capture of port A and/or B if Run is engaged.

Other functions than shown above are the same as in the Standard Screen mode.
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(3) Full Screen Mode

| S5-5200 0.0kV.0.0mm xT,50k -

Removes control buttons.

Shows conktrol buttons.

cereeeneeennn Se1S (OF releases) Overdrive mode for stage operétion with the
mouse. ‘ o

Other functions than shown above are the same as in the Standard Screen mode. -
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2.3.6 Op'eration Using Mouse on the Image

Focusing, astigmatism correction, image brightness and contrast adjustment, electrical image
shift and stage can be operated on the scanning image display using the mouse.

The mark of the mouse pointer changes depending on the position on the image display as
shown below. Each mark shows the function of mouse operation available at the position.

i@ at lower half of the i |mage ......

Focusmg -
Move the mouse while holdlng down the Ieft button for fine

-focus or the right button for coarse focus.

@ﬁf@ at the top left quadrant

of the image

sessesesiessriirnsangssinararraras

Astigmatism correction.

-Drag the mouse while holding down the left button for X or
‘the right button for Y correction. : ‘Repeat Xand Y

%P at the top right quadrant

of the i image

ssrrsanearermvanansrenns N RERERe Y

corrections, and focus, for a final result.

Brightness and Contrast 'adjustment

Drag the mouse while holding down the left button to adjust
brightness; while holding down the right button to adjust
contrast. Drag it to the right to increase and to the left to
decrease brightness and contrast.
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) at near the center e L e i
of the image.......cccovevevevevereeneen. Starting stage or electrical image shift operation.
- Double-clicking of the mouse when the mouse cursor is -
above Hand mark changes its cursor to the Beam-Hand. - -
mark. g :

L. Stage-Hand mark: Stage operation

- When the mouse cursor in'the Scanning Image area |s the Stage -Hand mark, the

stage can be driven in two ways.

1. Stage Dragging : o v
Place the mouse cursor at a start point on the scanning image. - Move the
mouse to an end point wh|Ie hotdlng down the left button (a red hne is drawn),
and releaseit. =
The stage is then dnven so that the tmage at the start pomt moves to the end
point. ~

2. RISM functlon : :
If the end point of the above operatron is near the center of the |mage the red
line is changed to a yellow line and the end point is positioned at the center of
the image. When the left mouse button is released, the stage is driven so that
the image at the start point moves to the center of the viewing screen.
To cancel the stage operation, click the right button of the mouse, or click
the button in the Stage area of the Scanning Image window.

Beam-Hand mark Electrical Image Shift operatlon : '

While the mouse cursor-in the Scannlng Image areais the Beam Hand cursor

the electrical image shtft can be driven. tn two ways as follows o

1. Mouse Dragging
Place the mouse cursor at a start point on the scanning rmage Move the
mouse to an end point while holding down the left button of the mouse (a red line
is drawn) and release it. . The image at the start point moves to the end point.

2. RISM function
If the end point of the above operation is near the center of the image, the red
line is changed to a yellow line and the end point is positioned at the center of

" the image. -When the left button of the mouse is released, the image at the start

point moves to the center of the viewing screen.

To cancel the electrical image shift operation, click the right button of the mouse, or click -
- the button-in the Beam area of the Scanmng Image window.

To star the stage or electrical i image shift operation, you may also click the

the Stage or Beam area of the Scahning Image window.

button in

The Stage-Hand mark and Beam Hand mark appear alternatlvely by double chcklng the
mouse. ‘
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2.3.7 Captured Image Window

On this window a list of captured images is displayed. It opens when you have captured an
image. " Also it:can be opened by selecting Captured image command from Wmdow menu or
using the short-cut key (Ctrl + L). ’

The minimize button on the title bar iconizes the window and places it on the task bar.

A red color number indicates the selected i |mage and a yellow color indicates the next capture
number.

Thumbnalls

Thumbnails of captured i |mage
Click an image to seta selected
number of image. '

Image Information:

Capture number, image signal,

accelerating voltage and

magnification of each image are
_ displayed

View button:
Opens a Viewer window and
displays a selected image in it.

Clear button:
Display button: Clears the selected image.
Displays the selected image in the g '

Scanning Image window. All Clear hutton:  Clears all images.

Capture Area button:
Sets a selected image area as the

PCI Transfer button: capture area.

Transfers a selected image to PCI.

This button is available when PCI _- Photo button:

software is inslalled. : Takes a photograph of the selected
image.
Save button:

Saves the selected image.

Close button: Closes the window.

Refer to:  3.6.4 Image Capturing
2.3.34 Save Image Dialog Window
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2.3.8 SEM Data Manager Window

SEM Data Manager is an image-fil
To open this window, click the
command from the File menu.

Slide show
controls

Page button

Thumbnail
checkbox

Thumbnail
display

(1) Toolbar

Make' New User...........

Delete User .................

Image Save.......... SO

Image Print........ccc.......

R

Bg Batch Process.............

ing program with an easy-to-operate database function.
button on the toolbar or select the Open SEM Data Manager

Image area

Image
information

Adds a new user name. A dialog window for entry of a new
user name opens. '
Deletes a user name selected from the User list box.

A message dialog window confirming delction will open.
Before deleting a User, all images in the User must be
removed from the user database using Batch Process- -
Remove List or Delete Image command.

Saves selected images to disk. A message appears-“The
file {File name} already exists. Over writeit? If OKis
clicked, the image is overwritten to the same file, and if No is
clicked, the Save Image dialog window opens.

Refer to: 2.3.34 Save Image Dialog Window

Prints images using Window-supported printer. The Print
Setup dialog window opens.

Refer to: 2.3.31 Print Setup Dialog Window

Enables file operations for archived images. The Batch
Process dialog window opens.

Refer to: 2.3.13 Batch Process Dialog Window

e



mage Photo....

mage Transfer

. PC! Transfer....

............
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Adds image files to database. Opens the Add from File
dialog window for adding image files to the database.
Refer to: 2.3.12 Add from File Dialog Window
Copies the selected image to the Windows clipboard.

Copies the selected image to the Windows clipboard.

~ Image size is reduced to 640 x 480 pixels when the original

size is 1280 x 960 or 2560 x 1920 pixels.

Opens Viewer window and displays a selected image.
Image processing and contrast conversions are available
through the Viewer window. ‘

Refer to: - 2.3.9 Viewer Window

Controls overlay writing and editing. The Viewer window
and Data Entry toolbox open. '

Refer to: 2.3.22 Data Entry Toolbox

Records a photograph of a selected image. Optional photo
recording unit is necessary.

Transfers a selected i image to the SEM and displays lt in the
Scanning Image area.

Transfers a selected image to the PC! window. (provided by
Quartz Imaging Co.) Available only when PCI software is
installed.

Opens the Help file of SEM Data Manager. The F1 key is
also available to open the Help. '

Indicates the version of SEM Data Manager.
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@)

(3)

(4)

Image Information
User list box............ eeviisnaeiniis

Select query DOX..evvnn.. S

Image File |lSt eteetererees e

User names reglstered on database are displayed. To select
a User, click a User name. :

Selects search criteria. For example if “Acc. Voltage
selected here, images with the specified acceleratlng voltage
are searched for and listed. :

Selection items include: All Images, Sample Name

Keyword 1, Keyword 2, Media, Image Format, Image
Directory, Acc. Voltage, Signal, Date, Lens Mode, Data Size.
Image files selected with User name and Select query are

listed here. An image selected from this list is displayed in

Image Information area.......

Thumbnail

Thumbnail check box........... |

Page button......cccccoeeeveereen. .
Slide Show controls .............

Thumbnail display .................

Image Area

Displays a selected image fro

the Image area and information of the image is displayed in
the Image Information area. , A
Displays information corresponding to the selected lmage
To edit information, click the Edit button. Sample,
Comment and Key Word are available for editing.

Input text in these categories and click the OK button.

The Cancel button cancels input.

If checked, thumbnails of image files listed in the Image File
list are displayed.

Displays next or previous page of thumbnalls when more than
40 images are included in the current selection.

Starts and stops slide show mode. Interval time is selectable
in the selection box.

Up to 40 thumbnails are displayed. Use Page button to
display next or previous page when more than 40 images are
included in the current selection.

m the Image File list. Double-clicking the image opens the

Viewer window with the image.

NOTICE: Windows color palette is fitted to the selected image. If both color and gray scale
images are included in thumbnails, color of unselected image may be disturbed.
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2.3.9 Viewer Window

The Viewer window displays a selected image at the actual size or at half or a quarter of the
original image size. T e e ' S ‘ ‘
Zooming, image processing and contrast-conversions are available in this window.

Displays the first image in the Image File list.

et

Displays the previous image.

Displays the next image.

Displays the last image in the Image File list.

Opens Slide Show controller.

Opens Contrast Conversion dialog window.

Refer to: 2.3.10 Contrast Conversion Dialog Window
Opens Image Processing toolbox.

Referto: 2.3.11 Image Processing Toolbox
Turns ON and OFF the zoom function.
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2.3.10 Contrast Conversion Dialog Window

The Contrast Conversion dialog window shows a histogram of the image when opened
Contrast and brightness control is available in this dialog window.
To open the dialog window, click the button on the Viewer window:.

1. Min Level marker .t.‘i‘..'.'.\.'.‘.‘...Sets the gray Ievel to be set at the mrnrmum Ievel with Manual
s ;_Conversuon operatlon _ 2
» _Drag the marker with the mouse

2. Histogram dlsplayA h,i§t°9'3m of the,‘image i,r_i th‘e Vlewer window is displayed.
3. Max Level marker............ Sets the gray level to be set at the maximum level with Manual

Conversion operation.
- Drag the marker with the mouse.

Selects a level of gamma correction and applies gamma
carrection of the specified value.

Decreases contrast by 10%.

Increases contrast by 10%.

Decreases brightness by 5%.

.Increases brrghtness by 5% ,

Adjusts contrast automatrcally SO that the histogram covers a fuII
range of the gray scale. '
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Expands contrast so that the two levels specified by Min Level and
Max Level markers cover a full range of the gray scale.

Inverts the gray scale settings of the image.

Apphes conversion results to the orlglnal image and closes this
R , - dialog window, (R -

Cancel button.......‘ ..... ..... .....Cancels the converS|on results and closes this d|alog window.

2.3.11 Image Processing Toolbox

Processing of an image in the Viewer window is' performed by commands on this toolbox.

To open the toolbox, click the button on the Viewer window. :

In the Viewer window, the result of any processing is applied to the original image by clicking the
OK button, or canceled by clicking the Cancel button. The Contrast Conversion dialog
window can be openéd from this dialog window as well. The available processing features are
listed below. -

2x2 pixels averaging, used for

noise reduction. 3x3 median filter, effective

far reducing noise.

3x3 pixels averaging, used. Increases image sharphess.
for noise reduction.
Laplacian filter, used for
edge enhancement.

Further increases image sharpness._\

Laplacian filter, used

for edge detection. ,/Line segment extraction.

Highlight filler emphasizes
/ detailed construction

and reduces shadawing . .
- of the image.

Differentiaté'thé image
(Differential direction is
from upper-left to lower-right)~~

Rotates the image by

Highlight filter further emphasizes -~ 90° clockwise.

detailed construction and reduces
shadowing of the image. Reverses the left and

right of the image.

Inverts top and bottom of the image: Opens Contrast Conversion

dialog window.

Applies'processing results to Closes the d!alog window.
the original image. ,
Cancels processing results.

M
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2.3.12 Add from File Dtalog Window

Adds image f|Ies to the SEM Data Manager database
To open the dialog window, click th button on the SEM Data Manager window. -

File Name .................. Select files to be added to the database. - Multiple selection using Shift
‘ or Ctrl key is available..

For multiple files selectlon,
(1)  Press the left button of the mouse at the first file to be selected, and

- move the mouse while holding down the button to the last file to be
- selected, and then, release the button. . Selected files are shown in
reverse color.
(2) Click the first selected file and then, click the last selected file while
holding down the Shift key.
(3) Click selected files while holding down the Ctrl key.

Folders............ erennees Select a folder. ‘

File Type......ccco....... Select a file type.
Add button ................. Adds selected files to the database.
Close button.............. Closes the dialog window.

NOTICE: Only file information is registered to the database. Image files themselves are not
copied. To open image files in removable media using the SEM Data Manager, the
* medium must be correctly set to the drive. -
It is recommended to attach an individual volume label to removable media using
Windows function. You can select image files in the medium by cllcklng the volume
label shown by selecting Media in the Select query box.
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2.3.13 Batch Process Dialog Window

The Batch Process dialog window is used for file operations. Use this dialog window for file
operations such as copy, move or delete for maintaining the correct information in the database
of SEM Data Manager. Use of Windows explorer or File Manager for such operations may
cause troubles with the SEM Data Manager operation.

To open the dialog window, click the

Action buttons
Move Files

Copy Files/Resize :

Copy Files Only

Convert/Copy

Move to User

Remove List
Delete Image

Rename Image

button on the SEM Data Mahager window.

Moves image files selected from the Source list to other folders

‘specified in the destination area. Ifnage filés in the source directory

are deleted.

Copies images files selected from the Source list to other folders
specified in the destination area.

Copies images files selected from the Source list to other folders
specified in the destination area. Files in target folders are not
regislered in the database. Use this command to copy image files to
floppy disks for carrying data to other PCs.

Converts image format of files selected from the Source list and then
copies to other tolders specified in the destination area.

Moves images selected from the Source list to another User database
Moved images are removed from the source User database.

The image files are not moved.

Image files selected from the Source list are removed from the
present User database. Image files are not deleted.

Deletes image files selected from the Source list and removes them
from the present User database. Image files are deleted.

Renames an image file selected from the Source list.
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Source list..................... Image file names included in the selected User with the selected item
(query) are listed here. Files can be selected from this list for one of
- the above actions. Multiple selection-using the Shift.or Ctrl key is
supported. » :
For multiple files selection, : v
(1) Press the left button of the mouse on the first selected file, and
| move the mouse while holding down the button to the last
selected file, and then, release the button. Selected files are
... shown in reverse color.
(2)  Click the first selected file and then chck the: tast selected file
. while holding down the Shift key.
(3) Click selected files while holding down the Ctrl key.

Destination drive and ,

folder list box................. These are enabled when Move Files, Copy Files, Copy Files Only or
Convert/Copy actions are selected. Select a target folder.
The Media ID indicates the volume label of the selected drive.

NOTICE: Itis recommended to put independent volume labels on removable disks such as MO
and ZIP disks. = The volume label is shown in the Media ID area.
To put a volume label on a disk, right-click the drive name in the Windows Explorer,
Select Property (R) on the pop-up menu. You can check or set a volume label in the
Information tab.

User boX.......ccevvievienennn. This list is enabled when Move Files, Copy Files, Convert/Copy and
Move to User actions are selected. With the exception of the current
User, all other Users are listed. Select a User for selected Action.
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2.3.14 Slide Show Controller
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Use the Slide Show controller for viewing images in continuous slide motion on the Viewer -

window. ~ - _
To open the Slide Show controller; click the

Starts slide show modg.

Staps slide show mode,

Interval.................. Selects interval time.

Close button.......... Closes this Cpntrollér.

button on the Viewer Window,; N
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2.3.15 Alignment Dialog Window

The Alignment dialog window is used for alignment operations.

To open the dialog window, click the Wobbler button in the Scanning Image window or the
Column Alignment button on the toolbar.  Or select the Alignment command from the
Operate menu. When the dialog window is opened with the Wobbler button, Aperture
Alignment (when the magnification mode is High Mag) or Low Mag Position (when the
magnification mode is Low Mag) starts as the default setting. -

Referto: 3.4.2 Column Alignment Operation

2 3 4
1
5
7
8
6
1. Function select buttons........ Starts each alignment function. Off stops functions.
2. Aperture Align button.......... Starts Aperture Alignment function. It is the same as the
Aperture Align select button. But it is an independent button
: since it is used frequently.
3. Resetbutton........................ Resets alignment of the selected function.
4, Reset All button .................. Resets alignment of all functions.
5. Alignment
operation area ..................... This area is used for adjustment operation. When the mouse
pointer is , you can make adjustment both in X and Y
directions by moving the mouse while pressing the left button.
When the mouse pointer is | adjustment direction is
restricted in X or Y direction.
6. Autobutton ......................... Executes auto axial alignment in the Aperture Align or Stigma
Align mode that was selected at 1.
7. Defaultbutton..................... Click this button when the deviation in Stigma Align mode is
particularly large.
8. Close button........................ Stops the alignment operation and closes the dialog window.
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2.3.16 Column SetUp Dialog Window

The Column SetUp dialog window is used for setting cdditions of the Electron Optical Column.

To open the dialog window, click the Column Setup
Column SetUp command from the Setup menu.

button on the toolbar or select the

Refer to: 3.4.1 Selecting Electron Optical Column Condition

¢ Height Mode list bOX..................

Focus indicator .......c.ocevevnnvennnee.

Free check bOX.....cccccovvvvvvnvvenneen.

Reset button.........coccoveveveeevennnes
Probe Current list box................

Selects a sample height condition. The sample height
selected in this mode allows optimum electron optical lens
condition.

Indicates the present focus position relative to the sample
height condition.

By checking this box, focusing range is expanded up to full
range determined by the accelerating voltage. After focusing
a primary beam on a sample surface, un-check this box.

Then the appropriate Height Mode value is selected
automatically.

Resets the focus position at the specified sample height.
Selects a range of the probe current adjusted by Cond Lens1.
For high resolution observation with small probe current, select
normal mode. And when a large probe current is necessary
such as for X-ray analysis, select analysis mode.
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Cond Lens 1 check box

and listboX.......ccevveevivnnrerinsinnnas When the box is checked, the 1st condenser lens is excited to
- . thevalue selected in the list box. LR
Cond Lens 2 check box.....-......_.. When the box is checked, the 2nd condenser lens is excited.
Focus Depth list box.................. It is possible to change depth of field by setting a:value in-this
list box. Usually set a number 1.0 in this list box for normal
operation. ' o

Mode Select list box :

(for Low Mag Mode) ................... Selects three different condltlons in Low Mag mode.
,(Normal / W|de / X- ray)

Probe Current list box

(for Low Mag Mode) ......... eerereen S elects a range of the probe current adjusted by Cond Lens1.
This condition is effective only in Low Mag Mode and is
independent of High Mag Mode

Flashing Intensity list box......... Selects flashing intensity. '; _

DeGauss button.............cc.ccc... ... Resets the objective lens current for degaussing the objective

" lens. This is effective to improve the magnification accuracy

especially when focus is manually adjusted in the wide range.



2.3.17 CD Measurement Dialog Window (Option)

To open this dialog window, click CD Measurement button
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on the toolbar or select the

Measure command from the Analysis menu. When the optional auto CD measurement

function is not installed,

Condition box .............

cursors for manual measurement appear on the image.

Used to call out registered CD measurement conditions. Upon clicking

- the selector button, the No. of the registered CD measurement -

Edit button ...

Save at Exit-button.....:.

conditions and a header will appear.

Opens the Condition window for ed|t|ng and reglstenng the CD
measurement conditions.

Saves the CD measurement condmons that are set when exiting the CD
measurement function. Note that setting cannot be made when the
condition registration is locked.
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Type....c.oovveiviiecinen, Specify the type of CD measurement.
s Standard button : Selects standard CD measurement (other than
.. width & pitch simultaneous measurement).
e W&Pbutton : Selects width & pitch simultaneous
- measurement.
o Multiple button : Selects successive CD measurements.
- This can be set when Standard has been

~ selected.
o Profile button : Selects a line profile display. This can be set
when measurement mode is Auto.

Mode............cccoovvinnnnnns Specify a CD measurement mode. :

e Autobutton : Selects auto CD measurement.

e Manual button : Selects manual CD measurement.
Direction...................... Select a measurement direction.

e X button : - Selects measurement in X direction.

e Y button : Selects measurement in Y direction.

¢ Angle button : Selects an angle measurement. This can be set

when the measurement mode is Manual.

Edge Detect ~ :

Direction...................... Select the edge detecting direction of the cursor box used to specify the
position including the edge to be detected, when X or Y has been
selected for the measurement direction. This is settable when the
measurement mode is Auto. The lcon varies with the measurement
type and mode. When Angle measurement has been selected, select
a circle cursor for the measurement side.

Set button...................... Displays a measurement cursor. The shape of the cursor varies with
the measurement type and mode.

Measure button............. Executes CD measurement.

Cursor Color button .....Specify the color of measurement cursor. Color changes in the order
of [white], [red], [green], [yellow], [blue], [violet], [light blue] at each click
of the button. '

Done/Uncalib display....Shows the applied result of calibration. When calibration has been
applied, Done plus a calibration No. will be indicated. And if calibration
has not been applied, Uncallb will be indicated.

Measured Data box ...... Displays the SEM conditions at measurement and the measurement

result.

Comment box............... A comment can be entered here. The entered comment is dlsplayed

: .. and saved together with the measurement resuit.

Cancel button................ Cancels the measurement result display. In the case of successive
measurements, the final measurement result is canceled.

Save button....................Saves the measurement result in a text file.  Upon clicking the button,
the File Save window appears. .

Calibration box............. Select the type of calibration. By selecting Auto Select, a suitable

type of calibration is applied automatically. .
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Edit button .................... Displays the Calibration window for registering the calibration.
Close button.............. .... Terminates the CD measurement. If the measurement resuit has not
' been saved, the File Save window will appear.

2.3.18 Measurement Condition Window

This window is used for setting the various parameters for auto CD _méasurement; it appears
by clicking the Edit button in the Condition area of the CD Measurement window.
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Select the registration No..of the measurement conditions.

- A-maximum of 16 measurement conditions can be registered.

An asterisk (*) appears at the upper right of a No. that is a!ready

registered.

Prevents changing the measurement conditions.

Enter a header for the registration No. . Up to 16 half-size characters -
can be entered for the header.

....Specify the type of CD measurement.

Edge Detect
Direction.......................

Parameters...................

‘ e Standard button .. .Selects standard CD measurement (other .

than width & pitch simultaneous
. ... .. . measurement).
o W&Phbutton:. - - : Selects width & pitch simultaneous
T measurement.
o Multiple button = - : " Selects successive CD measurements.
- This can be set when Standard has been
. L = selected.
« Line Profile button : ~ Selects a line profile display. This can be set
~when measurement mode is Auto.
Specify a CD measurement mode.
e Auto button = : Selects auto CD measurement.
e Manual button . Selects manual CD measurement.
Select a measurement d|rect|on ‘
¢ X button . Selects measurement in X direction.
¢ Y button : Selects measurement in Y direction.
e Angle button : - Selects an angle measurement. This can be set
when the measurement mode is Manual.

Select the edge detecting direction of the cursor box used to specify the
position including the edge to be detected, when X or Y has been
selected for the measurement direction. This is settable when the
measurement mode is Auto. The icon varies with the measurement
type and mode. When Angle measurement has been selected, select
a circle cursor for the measurement side.
Set the parameters for auto CD measurement.
e Measurement Point box: .
Enter a numeric for the number of measurement points. If the set
value is 2 or more, measurement is made for only the specified
number of points while shifting by the Muiti Pitch value (scanning
lines), and the average value (Width), maximum value (Max.),
minimum value (Min.) and standard deviation (3 Sigma) are indicated.
¢ Measurement Pitch box: =
Set a scanning line interval (pitch) for integration of the signal profile
(line profile) corresponding to the scanning lines. For instance, by
setting “2”, a line profile is formed by integrating the number of lines
specified at Summing Line below while skipping one scanning line,
and edge detection is carried out. Setting range is from 1 to 64.
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e Summing Line box: .

Aline profrle is |ntegrated using only the specrfled number of
" scanning lines and edge detection is carried out. By specifying “8”,
for instance, averaging is conducted for a line profile corresponding
to8 scannrng Imes - The greater the number of lines, the lesser the

effect of noise. Settrng range is from 1 to 64.

o Multl Pitch box: :
Specrfy a measurement pornt interval when 2 or more ‘has been set
for Measurement Point. Un|t is number of scannlng Ilnes, and

. setting range is from 2 to'64." |

e Smoothing box:. T :
indicate the parameter for averagrng the line profile according to
scanning lines. Unit is number of pixels for averaging, and is
selectable from 1, 3, 5 and 7. This averaging serves to reduce -
noise in the SEM image srgnal (llne profile). By utilizing the signal
profile averaged by means of both the aforementioned line profile
integration and Smoothing, edge detection is conducted according
to the specified method (linear approximation or threshold method).

» Design Value box:
Specify an interval between cursors (two boxes) used to specify
measurement. Unit is um, and the input range is from 0.1 to
200 um.

e Design Pitch box:
Specify a pitch for width & pitch (W & P) simultaneous measurement.
Input range is from 0.1 to 200 um

o Search Area box: :
Specify a width (edge detection area) for the cursor box.
Unit is number of pixels, and the range is from 16 to 160.

In-auto CD measurement, the length in measuring direction of the cursor box

- indicates the measuring range, and it varies with the parameters set in the above.

This length is equivalent to (Measurement Point-1) x (Multi Pitch) + [(Summing Line)
x (Measurement Pitch)] (unit is number of scanning lines), and an input exceeding

.- 480 lines is not permitted. Therefore, even.if the value is within the limits of the

- entered numerics indicated in the parentheses above, an input may be inhibited.
- Number of measurement points is input via a numeric. - If the setting is 2 or more,
-.measurement is made for only the specified points while shifting the Multi Pitch

interval (scanning lines), and the average value (Width), maximum value (Max.),
minimum value (Min.) and standard deviation (3 Sigma) are indicated.
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Cursor width .
(Search Area) Cursor interval

\ ] . (Design Vaiue)

Typical measurement
point interval (Multi
Pitch=10)

(Summing Line = 4)

"H

Measurement pitch
1' @/‘ (Measurement Pitch = 2)
. > Line integration

l

Measurement operation

Typical measurement

Entire measurement—
area (cursor vertical
dimension)

value

Number of measurements

= Meas. Point

’\\

=
Measurement cursor

(box)

Edge Detection ............

Object measurement
pattern

Set parameters specific to each edge detection method.
¢ Linear Approximation button:

Selects linear approximation for the edge detection method in auto
CD measurement.

Threshold Level box: .

Set a threshold level for the linear approximation. Input range is
from 5 to 95. If a standing wave or the like is included in the pattern,
for example, a number of steps will appear at the edge part, and this
may cause an inappropriate edge detection. In such cases, try
changing the threshold setting to obtain a suitable edge detection.

In the linear approximation method, a slope line is detected upon
finding a local peak (of maximum size) of the signal gradient in the
direction of edge detection. If two or more slope peaks (local slope
peaks) exist at this time, then assuming the maximum value of signal
gradient of the edge part is 100, a slope line is determined from the
first local slope peak that is larger than the entered threshold value.
Therefore, if the signal gradient peak is a single monotonous signal
waveform (line profile), the detected edge is not dependent on the
threshold value.
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o Differential Size box: : .
This is a parameter for calculating the 5|gnal gradient (differential
coefficient of signal) in the linear approximation method. -
The normal setting is 5. Set it at 7 if measurement is unstable due
to much noise on images. Select a value from 3, 5 and 7.

e Base Line Startbox: - PREe
This parameter determmes the startmg point for reading the signal
baseline in the linear approximation method. The baseline is
decided by the average signal level in the range specified at Base
Line Area below, from the position determined at Base Line Start.
Base Line Start is selectable from 1, 2, 4 and 8. The lower this
value is, the nearer the starting point for reading the baseline is to
the maximum gradient position of the signal, and the baseline will
shift upward. :

e Base Line Area box:
Specify a range for baseline réading in the linear approximation
method. This is selectable from 4, 8, 16 and 32 (unit is number of
pixels). - ;

¢ Threshold button:
Selects the threshold method for edge detection in auto CD
measurement,

¢ Threshold Level box:
Set a threshold level for the threshold method. Enter a numeric on
the assumption that the difference between minimum and maximum
signal variation at the edge partis 100. If 50 is set, for example,
cutoff will be made at an intermediate level. Input range is from 5 to

95.
Apply button.................. Sets the cursor shape under display according to the setting.
Also saves the measurement parameters in the registered No.
Save button.................... Saves the present settings in a different registration No. A window for
specifying the registration No. of the save destination is dlsplayed
Del button......... e Deletes the registration,
Close button.................. Closes the Measurement Condition window. If measurement

conditions are being edited, a save confirmation message will appear.
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2.3.19 Calibration Window

Used to calibrate the measured values. - This window appears by clicking the Calibration button
on the CD Measurement window. - SRS o

Entry No. boX...........c...ie e, Specify a No. for registering the calibration. An asterisk (*)
. : ‘ appears at the upper right of a No. that is already registered.
Caption boX ............ccceeeeereeninnns Enter a header for the calibration. Up to 16 half-size characters

. - .can be entered for the header.

Calibration Condition box ...... Display the SEM conditions at calibration.

Set button..................cccceil Displays the measurement cursor for calibration according to the
measurement conditions. Color of the cursor follows the
Cursor Color specification on the CD Measurement window.
For calibration in manual measurement, align the measurement
cursor (both X & Y directions) with a position of known
dimensions on the window. For calibration in auto
measurement, adjust so that the edge part of the measurement
pattern is included in the cursor box.

Measure button........................ Executes measurement over the distance specified by the
measurement cursor.
Measured Value boxes............ Display the measured results prior to calibration.
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Correct Value boxes................ Enter the calibrated values.: ..:- -
Calibrate X/Y buttons............... Calculate the calibration factors.

Calibration Factor boxes ........ Display the calculated calibration factors.. - Assuming the
- -~ measured value (Measured Value indication) is Lmand the
value to be calibrated (Correct Value entry) is Lt, the calibration
factor C is obtained by the following equation.

Apply button................cccocee.... Registers the calibration.
Delete button.......................... Deletes the calibration registration.
Close button..................c.......... Closes the Calibration window.

2.3.20 Comm Port Setting Dialog Window. -

Set parameters for the RS-232C communication ports. Use this command only when change
of the parameters is required. Unexpected'change of the default parameters may cause

troubles. :
It opens by selecting Comm Port Setting command from the Option menu.

CommPOrt.......cccccconvvrannn, Selects one of communication ports.

Speed .............................. S6lects communication speed in baud rate.
Character Length............, Selects character length. ‘
Parity ......... i eres i .. Selects parity bit status.
StopBit............ccooeeeee Selects stop bit status.

Hand Shaking .................. Selects hand shaking method.

Retry...........ccccccvieinnniinnn Selects retry times.
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2.3.21 Data Display Dialog Window

The Data Display dialog window is used for setting conditions related to the auto data display
function. To open this dialog window, click the Data Display button on the toolbar or select
the Data Display command from the Setup menu. -

Auto Data Display checkbox..... Auto data display is engaged when this box is checked.

Magnification, Micron-Marker, :

Vacc, Height, Date, Time,

Data Number, Signal Name

check bOX........ccoviiviiiiiiiccennnn, These items are included in data display if checked.

Auto Increment check box......... When the Data Number has “-nn” at its end (n: numerals, for
example “Hitachi-00" ), Data Number is incremented with each
successive photograph. Maximum count is determined by the

“number of digits from “-” and subsequent.

Data Number input box.............. Input data number into this box. Up to ten characters may be
keyed in. Do not use “," (comma) and “ " (space). ‘

Back Ground Image :

checkboX........cccceviiiiiiiiec, When this box is checked, the data display is overlaid on the
scanning image. If it is not checked, the background of the
data display area is black.

Embed into Image

checkboX.........cooecivvveieiiiiiienn . When this box is checked, the auto data display is embedded
into the image data when the image is saved to disk. If it is
not checked, only the image data is saved. This setting is
also applied for Print, Copy and PCI Transfer commands.



For Photograph check box
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....... Selects the position of the auto data display to be printed on

images. If this box is checked, the position of the auto data
display in the saved image is shifted slightly upward to ensure
that it is properly framed in photographs. It is recommended
to not check the box if the saved image data will be used on
the computer only. '

NOTE: The Embed into Image optioh is effective also for printing, copying to clipboard and
' PCl transfer. For photo recording, the auto data display is recorded whenever it is
~ shown on the image, irrelevant to the option setting.

23.22 Datav Entry Toolbox

Data Entry toolbox controls graphics and text OVerIay onimages. To open this

toolbox, click the Data Entry

button on the toolbar or select the Data Entry

command from the Image menu.

NOTICE: 1.

Overlaid graphics and texts are put on photographs or image files
when photo recording, direct saving, printing, copying to the

~ clipboard or PCl transfer is done while these are shown on the

image. ‘
Note that when above operations are done with buttons on the

‘Captured Image window, graphics and texts are not applied on

images. To put data on a captured image, copy a captured image
to the scanning image window by clicking the Display button and
then make above operations.

Dimensions put to Measure Inner/outer Dimension marks are
re-calculated and re-displayed when freezing or recording operation
(direct photographing, printing, copying to clipboard) is done to
keep them correct on recorded images. On scanning image, they
may not be correct if magnification is changed after drawing these
marks.

Overlays text on the image. Click this button and then, click the
starting point on the image. A text input area is shown with black

- background. Input text and terminate with the Enter key.

While this button is pressed, text input can be repeated on the
image. When a text is written in the Text box , this text is placed at
the top of the text input area. The font of text can be selected by
double clicking the Text box, which opens the Font Select dialog
window. The font of text can also be selected in the Environment
Setting dialog window.
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button ...................o: Overlays lines on the image. - Click this button, and press the left:
... 'button of the mouse to create the starting point of the line on the
... image... Move the mouse to an end point and then release the
... button of the mouse.. While this button is depressed, you can
_ e 'repeat a line drawing.
BUON oo Overlays single-head arrow marks on the image. Click this button
and press the left button of the mouse to create the starting point of
the arrow on the image. Move the mouse to an end point and then
release the button of the mouse. Whlte this button is depressed,
you can repeat an arrow drawmg '
Overlays double-head arrow marks on'the i |mage Click this button
and press the left button of the mouse to create a starting point of
the arrow on the image. Move the mouse to an end point and then
release the button of the mouse. While this button is depressed,
'you can repeat an arrow drawing.
rs Overlays an inner dimension mark on. the lmage Click this button
~ and press the left button of the mouse to create a startmg pointon
the image. Move the mouse to an end point and then release the
button of the mouse. While this button is depressed, you ‘can
‘ repeat the drawing of an inner. d|men3|on mark. L
button ...........ccoeeeeni Overlays an outer dimension mark on the image. Click thls button
' ~ and press the left button of the mouse to create a starting point on
the image. Move the mouse to an end point and then release the
button of the mouse. While this button is depressed, you can
repeat drawing of an outer dimension mark.
button ............... ....... Overlays an outer dimension mark with a measurement on the
image. Click this button and press the left button of the mouse to
create a starting point on the image. Move the mouse to an end
“point and then release the button of the mouse. While this button
is dep'ressed, you can repeat drawing of an outer dimension mark.
‘Overlays acircle or oval shape on the image. Click this button and
- _press the left button of the mouse to create a starting point on the
image. Draw a shape by movmg the mouse and then releasing
the mouse button. While this button is depressed, you can repeat
drawing of a shape.
Overlays a rectangle on the i |mage * Click this button and press the
left button of the mouse to create a startlng point on the image.
Draw a shape by moving, the mouse and then releasing the mouse
~ button. Whlle th|s button is depressed you can repeat drawing of

B “V._‘a shape. )
Shadow button ..... IR ... If the Shadow box is checked texts and graphics are overlaid with
. a ‘shadow.
Text box .......... e .'“Input text in this box when for example the same text is required

for many text overlays “The text in the box is placed at the top of
the text input area. Double-clicking this box opens Font Select
dialog window.
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B B .. ¥ or §] button selects graphics or text on the image in‘order.
oot e o oo A gelected graphics isindicated with red color and a surrounding
- dotted line box.. A selected text is indicated with red color and
.. black background. : - They can be moved and re-positioned by
-.- mouse dragging.- ‘A selected text can be edited by double-clicking
~-onit.. The text line is prolonged and editing becomes possible.
ST - .- 8 button:selects all graphics and text.
Clear button ................. ........Clears selected graphics or text.

Display check box................Shows (checked) or hides (unchecked) text and graphics.
Combine button................ .. This-button will be shown only when opened on the SEM Data

LR L Manager. - It embeds overlaid text and graphics into the image.
Close button..;....; ............. ... Erases overlay and closes this toolbox.

2.3.23 Environment Setting Dialog Window

The Environment Setting dlalog window has seven tabs
To open this d|alog window, select the Enwronment Settmg command from the Optlon menu.

(1) Environment Tab Strip

_,The Environment tab is used to select the controls for mouse operation on the scannlng
image, and the data transfer to and from the PCI software, and to set the automatlc rotatlon
correction linked with sample height.

Image Adjustment area......... Mouse operation functions (focus, astigmatism correction,
and brightness and contrast adjustment) are all available
when the Adjust All box (in the Scanning Image Wihdow) is

- checked. When the Adjust All box is not checked, only
‘the functions checked will be active.
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Raster Rotation area.....

Micron Marker area .......

OK button, Cancel button

(2) Font Tab Strip

When the On button is selected for Height-Rotation Link,
image rotation caused in the objective lens is compensated
automatically and the scanning direction is kept to coincide
with the direction of stage movement. [f the Controllable
button is selected, the automatic compensation function is
enabled or disabled with controls in the Raster Rotation
dialog window. - For normal operation, it is strongly
recommended to select the On button.

Select the method of marker display on the Scanning
Image window. At Sizable, the marker length varies
according to the magnification, to the extent that a fraction
doesn’t appear in the indicated value. . At Fixed, the
marker length is fixed, and only the value indicating the
length varies with the magnification. In this case a fraction
will be indicated with the length in accordance with the
magnification. ” .
Click OK button to make selections available or the Cancel
button to cancel selections.

~ The Font tab is used to select the type and size of the font used in the Data Entry and CD

Measurement functions.

Data Entry/
" Measurement check box

OK button, Cancel button

The name and size of the present font is indicated.

To select a font, open the Font dialog window by clicking the
Set button .

Click OK button to make the selection available or Cancel
button to cancel the selection. ’
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(3) Stage Tab Strip
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The Stage tab is used to set function of specimen stage.

Stage Drift Comp

This function minimizes the stage drift just after the stage is
moved by using RISM function or by specific coordinate.
When clicking the “On”, the stage (X,Y) will move past the
target position by the drift comp. amount (approx. 0.2 4 m to
1 u'm) and then return to the proper target position.

This action reduces the stage drift. Note that the stage
operation will be ignored if the stage traverse is less than 1/2
of the drift comp. amount. If this setting is set to “Off”, the
minimum traverse range of 0.1 um is effective.
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(4) Mouse Tab Strip

The Mouse tab is used to set the sensitivity of mouse: operation-(focus, stigma, brightness
and contrast adjustment) in the scanning image.

Set the sensitivity of mouse operation (focus, stigma, brightness and contrast adjustment)
in the scanning image... Set a slider control at the Slow side for lower sensitivity or at the

. Fast side for higher sensitivity. .- Adjustable range.is a half to 1.5 times the default
sensitivity. - . o oo T : ‘

5) SEM» Data Manéger Tab. St»rip

Thumbnail Directory ........... Set the directory where the thumbnail data for the SEM Data
Manager is stored.
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(6) Image Size Tab Strip

The Image : Stze tab is used to set size of images placed ona page usmg the Layout
command of DTP apphcaﬂons such as Aldus Page ‘Maker. The setting is effective only on
application programs that support the X and Y-Resolutton tags of Tiff files. The Aldus
Page Maker supports, and’ many of word processor apphcatlons do not support these tags.

Print Size X/Y .......ccooccviiiiinnn. Set the size of images when placed on‘a page using above
mentioned DTP apphcatlon programs Input a horizontal
Sonmioin v iz i the left side box. :
4" x 5" Photo Size button....... Sets the Print Size to the value by Wthh the magnification of
. ’ ' - images.placed on a page using above application programs
is about equal to the magnification of images taken with
x 5" Polaroid films. The size of | image is a little Iarger
than the effective area of the Polarord film.
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(7) Fast Scan Speed Tab Strip

Horizontal scanning speed of FAST1, FAST2 scan and FAST scan capturing can be set
slower by selecting 1/2 speed or 1/4 speed button. Use this function to reduce image
distortion in horizontal direction, or to obtain better image resolution. Note that slower
horizontal scanning speeds result in slower frame speed and longer capturing time.

(8) AAA Adjust Tab Strip-

Frame....... Select a number of image frames (integrated number of frames at alignment
image acquisition) to be used in auto axial alignment. The normal setting is
16. If an image of very poor S/N ratio is used in the auto axial alignment, the
alignment accuracy would likely be degraded. ~ [If the auto alignment fails due
to poor S/N of the image, set Frame to 32.
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2.3.24 HV Control Dialog Window

The HV Control dialog window is used for setup, application or shutdown of the electron gun high
voltage. To open this dialog window, click the mouse in the HV Dlsplay area or select the HV
command from the Setup menu. :

ON button................... Applies high voltage to the electron gun and controls extraction voltage to
obtain the emission current selected in the Set le box.
The name of the button is changed to SET when high voltage is applied,
so the emission current values can be adjusted.

OFF button.................. Shuts down the high voltage.

NOTE: You can tum On and Off HV using ON and OFF buttons on the toolbar when you do
not need to change high voltage value.

Flashing button.......... .. Opens a sub dialog for the flashing operation. Flashing is carried out
when the Execute button in the dialog window is clicked.

Vacc list box and - Coae T : ) SRR
up and down button.... Sets high voltage. - Select a voltage from the pull-down list, or by using
' the up or down buttons. At the top of the voltage list, four recently used
. . voltages are placed. R v S
Setle to list box ......... Sets emission current. - Select the desired current from the pull-down list.
Close button.....;...‘ ...... Closes the dialog window.
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2.3.25 Image Setup Dialog Window

- The Image Setup dialog.window

To:open this.dialog. window, click the image setup button

command from the Setup menu.

Preset Magnification
List.boxes........cictiviniinnciiinnns

Contrast/Brightness slider........

Adjust Beam Monitor slider ......
Capture Resolution

select buttons ..........c.ccocveeiinnns
Capture Speed/

Integratlon list boxes TP
Auto Increment check box........

Captured Memory Overwrite
check boX......ccoooviveniiiiiiiiiecne,

Screen Mode select buttons.......

is used far selecting conditions related to the scanning image.
.on the toolbar or-select the Image

.:Selects magnifications for the Preset button in the Scanning-

-Image window. Three magnifications:can be set using the

Preset Mag. button. Magnifications can also be entered using
the keyboard followed by the Enter key.

Contrast and brightness level can be adjusted for ABCC with
the sliders, if the results of ABCC are not suitable for observing
specimens.

If this box is checked ‘Beam Monitor adjustment is activated
automatlcally at the start of ABCC.

Selects the image resolution of captured images.

Selects the number of frames to be integrated for capturing at’

" Fast1 and Fast2 speeds. Also selects a scanning speed for
' "captiring at slow speed. - ‘

If this box is checked; the number of the captured area |s

" incremented after eaCh capture

If this box is checked, a captured image is overwritten without a
warning message.
Selects one of the screen modes.
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2.3.26 Login Setting Dialog Window

it opens by setting Login Setting.command from Optnon menu. " |t is possible only when -
logged in with the login name [S-5200]. ~ T e e Y
You can create or change login names and their password for each user.

Login Name list

Add button ............... et .-,-;- .V'Opens a dlalog wmdow for mputtmg a new Iogln name.

Delete button ......... evrbeeen ......-Removes the login name selected on the Login Name list:
The name [S-5200] is not removed.

Old Password box..................... Input present password here to change the password.

New Password box ................... Input new password for changing the password.

Confirm New Password box ....... Input the.new password once more for confirmation.

Change button .......................... The password of the selected login name will be changed to

new password. When you input only the present password

and click the button without entering new password, the

password is deleted and the user can Iogln without password
Close button.............cccccceeinine Closes the dialog window. : :

Referto: 3.11.17 Password Setting
3.11.18 Setting Login Name

NOTICE: Upto ieith:characters are allowed for login names and passwords.



2.3 Graphical User interface (GUI)

2.3.27 Oblique Dialog Window

The Oblique dialog window is used to display an oblique image. To open the dialog window,
select the Oblique command from the Analysis menu or click the Oblique button on the

toolbar.

55200
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Image check box................. When the box is checked, the original image is displayed in the
window in a reduced size.

Brightness Modulation

check bOX.......ccovvvvviveneninnas When the box is checked, the brightness of the profile lines, in the
oblique image, are modulated using the image brightness of the
corresponding-pixels.

Bird’s Eye check box.......... If the box is checked, the oblique image is shown as a bird’s eye
view.

Angle, Tiit slider and

indication box ..................... Sets the viewing and tilting angles. A higher resolution shows finer
detail but takes a longer time to draw. If the image is noisy, a
lower resolution will present a smoother image.

X Resolution list box .......... Selects a resolution of the horizontal axis. A higher resolution
shows finer detail but takes a longer time to draw. If the image is
noisy, a lower resolution will present a smoother image.

Y Line listbox ..........c.......... Selects a number of drawing lines of vertical axis.
Gainlistbox...........ccccoeone. Selects a modulation gain.

Gobutton ............oocvveieie Starts drawing an oblique image.

Cancel button..................... If clicked, the oblique image will stop being drawn.

Photo button ....................... Click this button to take a photograph of an oblique image.
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Save button......................... Click this button to save an oblique image to disk.
Saved images are not registered in the SEM Data Manager
database, but can be registered as image files in the SEM Data
Manager using the Add From File function.

Default button..................... Sets conditions, X Resolution, Y Line and Gain, at default values.

Close button.............c.......... CIoses the dlalog wmdow

2.3.28 Operating Condition Dlalog Wmdow o

The Operating Condition dialog wmdow is used for savmg, loading or deletion of conditions of
the electron optical column.

To open this dialog window,. select the Operatmg Condltion command from the File menu or
click the Operating Condition button # | on the toolbar.

File Name box and list box............ Input a file name in this box“ or select a file hame in the list
box by clicking a name. '

Stored Condition box................... The condition data written in the condition file selected in the
. File Name list box is indicated in this box Use this data to
confirm the condition before loading.

Current Condition box.................. Current conditions are shown in this box. ,
Commentbox............ crerersrenneenn. COMMents in the condition file selected in the F|Ie Name list
' box are shown in this box.

New Comment input box.............. Input new comments for saving.

Load/Set button ........................... Loads conditions in the selected condition file, and sets these
conditions to the instrument.

Save button............ccccoeoveiniennnn. Saves current conditions to a condition file.

Delete button..............ccccceeeniinne Deletes a file selected in the File Name list box.

Set Alignment Data check box.....If the box is checked, alignment data are set on the
instrument. ‘ '

Close button................cccccvvcninnnan Closes the dialog window.

Referto: 3.11.6 Condition Memory Function (Operating Cohdition)
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2.3.29 Password Settmg Dlalog Window .
Use the Password Settmg D|alog W|ndow for settlng or changlng the password of the login

name for current user. -
To open this dialog window; select the Password Settmg command from the Optlon menu..: "

Userbox............cccoeviiiinnennnn, The login name'of current 'user,is»;ind'i,cated.

Old Password box................. Input'present password here to change the password.

New Password box ................. Input new password for changing the password.

Confirm Password box............ Input the new password once more for confirmation.
OKbutton..........cc.oeeee.. .......... Changes the password and closes the window. When you

input only the present password and click the button without
entering new password, the password is deleted and the user
: can login without password.
Cancel button......................... Cancels input and closes the window,

Referto: 3.11.17 Password Setting

NOTICE: Upto erght characters are accepted as password Capital and small letters are

distinguished.
Setting login name is pos5|ble usmg the Logm Settmg dialog window. Itis cnly,w

accessible when logged in with the ‘superlntendent login name.
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2.3.30 Photo Condition Dialog Window - -+

To open the dialog window; click the Photo Conditio
Photo Condition command from the Se'tUpmenu'. '

button on the toolbar or select the

Photo Speed-Direct Photo ; A

list box.......... b Used for selecting a scan speed in Direct Photo execution.
The number of scanning lines is indicated. In common practice,
specify a scan speed of 80 sec. For a specimen which is liable to

- be damaged, it is recommended to specify a scan speed of 40 sec.

For X-ray image photographing, it is advisable to specify a scan
speed of 160 to 320 sec.

Photo Speed-Memory Photo

list POX.....vvvvviiieeciiiiiiiiiec s Used for selecting a photographing method (scan speed, number
of scanning lines) in Memory Photo execution. Selection of
Normal performs 960-line photographing if the number of image
data lines is 960 or less. Note that the photograph resolution is
2000 lines or higher. Therefore, inter-line parts may become
dark if 960-line photographing is performed.
Selection of Enhance performs 1920-line photographing even if
the number of image data lines is 960 or less. Therefore, inter-
line parts will not become dark. Note that the same data as that
on each preceding line is used on each increased line.
Select X ray Map for photographing an X-ray analysis map image.
Selection of this item automatically increases brightness and
contrast in photographing so that a clear map image will be
recorded. The number of scanning lines and the scanning time
(at a power frequency of 60/50 Hz) in each photographing mode
are as follows:
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Normal : Data of 640 x 480 pixels - 960 lines (17/20 s)
Data of 1280 x 960 pixels — 960 lines (17/20 s)

S - Data of 2560 x 1920 pixels — 1920 lines (34/40 s)
Enhance : Data of 640 x 480 pixels = — 1920 lines(34/40 s)
Data of 1280 x 960 pixels — 1920 lines (34/40 s)

<. .+ Data of 2560 x 1920 pixels — 1920 lines (34/40 s)

Xray MAP:; Data of 640 x 480 pixels  — 960 lines (17/20 s)

’ Data of 1280 x 960 pixels — 960 lines (17/20 s)

Data of 2560 x 1920 pixels — 1920 lines (34/40 s)

Brightness/Contrast sliders..... Sets brightness and contrast for photo recording. These are
compensation factors for brightness and contrast adjusted in the
scanning image. Adjust these values if a photograph does not
have adequate brightness or contrast.

Film-Film Speed list box........ Selects a film speed (sensitivity) of the film. The brightness
setting is changed internally according to the selected film speed.

Film-Photo Size list box ........ Selects a size of the film. The magnification is adjusted internally

: according to the selected size.
x1.0: For 4 x 5 inch instant film
x0.8: _For type 107 or 105 instant film
x0.6:. For type 120 negative film.
Also you can input any desired value other than above using the
keyboard. . o
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2.3.31 Print Setup Dialog Window

The Print Setup dialog window is used to print images using a Windows supported printer.
When opened by the Print-command in the File menu, the viewing image is printed. In this
case, only one image per page can be printed. When opened by the Print 12| button in the
SEM Data Manager window, up to eight images can be printed per page.

Page Format................................ Displays preview of the printed image. When two or more is
selected in the Image/Page selection box, selected humber of
areas for image preview are displayed.

The area surrounded by yellow box shows the selected
preview area. You can select an area by clicking a preview

area.
Printer indication...........cc............. Indicates the type of the default printer. To change the
printer, use the Printer command of Windows.
Image/Page selection button............ Selects the number of images printed per page (1 to 8).
_ Fixed at 1 when opened by Print command in File menu.
Image Select button..................... Opens Image Select dialog window. Select file names to be

printed in the dialog window. The Image Select button is
disabled when opened by the Print command in File menu.

Contrast/ Brightness contral.......... Adjusts contrast and brightness of the printed images.
) The adjustment applies to all selected images.
Include area...............c..cceeennnennn. Selects text printed with the images. Text of checked items

is then printed.

NOTICE: For small paper such as A6 size, excluding these texts may allow bigger image size.
When the Photo Size button is disabled or when selecting the Best Quality results
in too small a print size, uncheck these and try selecting Image Size option.
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Image Size area......................... Selects size of printed image. - If Photo Size is selected, the
image size is set to the same size as 4" x 5" Polaroid film.
~ If Fit to Page is selected, the image size is adjusted to fit the
paper size. . - When the Best Quality-is selected, printed image
size is set so as the number of dots of the printer includes:
- image area and the:number of pixels of the image data is -
- integer ratio. It will result in the best print quality for the
Rt thermal or dye -sublimation type pnnters -1t is not effective for
Iaser or mk jet type prmter usmg duthermg method.

Number of Copies

selection box ............. o Selects the number of coples to be prmted (1to 5).

Remove button ..............c.c......... ‘A preview image in the selected area is removed by clicking

B  this button.  Click a preview area and then, click the Remove
button to remove the image. -
" The Remove button is disabled when opened by the Print

command in File menu.

Print button ............. sieeeeiieeeni.... Starts printing.

Cancel button........................ .... Closes the dialog wundow

Properties button....................... Opens Printer set up dlalog window provided with the printer

driver.

NOTICE: Use the Setting-Printer command of Windows for setting detailed properties of the
prlnter : _ : . ;
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2.3.32° Pseudo Color Dialog Window -

The Pseudo Color dialog window is used for displaying a pseudo colorimage. - = = - "~
To openthe dialog window, click the Pseudo Color button : on the toolbar or select the -
Pseudo Color command from the Image menu..

Color Mode list box............. Selects a coloring mode.
‘Color Order list box............. Selects a color order.
‘Max Level shder ..... RS . Sets the maximum value of the signal assigned to color the i image.
~ Adjustable range is from 75 to 100% of the full scale.
Min Level slider ............. ... Sets the minimum value of the signal assigned to color the |mage
o Adjustable range is from 0 to 25% of a scale.
Color Bar check box....... ... Displays color bar at the right snde of image.

Refer to:  3.11.7 Pseudo Color Display
23.33 Raster’notétion Dialog"'Window "

The Raster Rotation dialog WIndQW is used for raster rotatlon dynamic focus and tilt
compensation functions.

| on the toolbar or select the
Raster Rotation command from the Operate menu. =
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Raster Rotation check box........ When the box is checked, the raster rotation function is active.
Refer to: 3.11.9 (1) Raster Rotation

Raster Rotation slider and -

up/down buttons.......................... Sets the rotatlon angle The rotatlon angle is mdlcated in the

box beside the buttons. It is possible to enter rotation angles

into the box using the keyboard followed by the Enter key.

... These buttons allow image rotation in steps of 90° from the

present visual field. : '

Dynamic Focus check box........ When the box is checked, the dynamic focus function is active.

: Refer to: 3.11.9 (2) Dynamic Focus

90° Rotation buttons

Dynamic Focus slider and -

up/down buttons...................... Adests' the level of dynamic focusing. The level is indicated in
a percent value in the box beside the buttons.

Tilt Compensation.............. e When this box is checked, the tiit compensation function is
active.

Refer to: 3.11.9 (3) Tilt Compensation
Tilt Compensation slider and R o o
up/down buttons............ SR Sets the tilt angle. The tilt angle is indicated in the box beside
' - the buftons It is possible to enter a tilt angle into the box
« o _ using the keyboard followed by the Enter key.
Rotation Link check box ........... This box is shown only when the Rotation Link is set at
o Controllable in the Environment tab of the Environment
Setting dialog window. ‘
When it is checked, image rotation caused in the objective lens
is compensated automatically and the scanning direction is
kept to coincide with the direction of stage movement.
When it is not checked, the automatic compensation function is
disabled and the C|rcu|try for raster. rotatlon |s passed through if
the Raster Rotation is set to Off. _
. For normal operation, it is strongly recommended to enable the
automatic compensatlon function.
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2.3.34 Save Image Dialog Window

The Save Image dialog window is used for saving viewing lmages captured nmages and
processed images in the SEM Data Manager. ' : :
To save:the image from the Scanning Image window, click the Direct Save button
toolbar or select the Direct Save command in File menu, after freezing the frame.
To save captured images, click the Save butto in the Captured Image window.

Simply frozen images are saved with 640 x 480 (or 1024 x 768 in Full 8creen mode) pixels
resolution. Captured images are saved with capture resolution.

To save a processed image in the SEM Data Manager, click the Save button
Data Manager window.

on the

in the SEM

“Vace =15kV.. . Height = 1.2mm

] 5520
Magnifioation’= #1000k Cu armal

File Name input box........ Specifies a file name. Input a file name for a new file or select one
from the list of files.
File Type box................... Specifies an image format (Windows bitmap, Tiff or JPEG).
Image area...................... Displays observation conditions of the image to be saved.
Folders list box ............... Lists folders of the selected drive. Select a folder on the list.
Drive list box................... Lists existing drives. Select a drive in this box.
MedialD ......................... Indicates the volume label of the selected drive.
Database area ................ Specifies items concerning the database.
User list box . Specifies User name where the saved image is to be registered.

Select a User name from the registered User names, or input a name
to create a new User.
Sample/Keyword
input box . Specifies Sample name and Keywords to be registered in the
database.
Select one from the registered names and words, or input new ones.
Comment input box : Input a comment.



::2.3. Graphical User Interface (GUI)

Save Option area......... Specifies a saving option. This option is disabled when opened from-
the SEM Data Manager.
Off .~ ... . Saves oneimage only.

Quick Save : File names are automatically generated for successive savrng operatlons
: {nput of a file name.is required once: Generated file names are: {Input file
name} + q+n s e T : - :
e n=1025000) : S
All Save .. : . Savesall |mages in the Captured Image wrndow F|le names [{Input F|Ie
name} + n (n: capture number)] are automatically.generated. .- This option is
.. available only when opened from the Captured Image window.

Save button..................... Executes image saving.
Cancel button..... -...Closes this dialog window. . e g e
New Folder button....... ’..L.Opens an |nput dlalog wmdow for creatrng a new folder
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2.3.35 Signal Processing Dialog Window =~

The Srgnal Processmg dlalog wrndow is used to select the number of frames to be averaged at

Fast scanning speeds, and to apply signal processing. -
To open the dialog window, click the Signal Processing button
Signal Processing command in Image menu.

“on the toolbar or seleét the

Frame Averagmg hst boxes...v.... Selects the number of frames to be averaged at Fast1 and
Fast2 scanning speeds. The recommended number of
frames is 4 at Fast1 and 8 or 16 at Fast2.

Signal Processing A (Left) o ' "

and B (nght) area TR ... Selects processmg for the scanning image displayed on the A

‘ “and B screens. B (Right) is available only when the Dual -

_ Screen Dlsplay mode is selected.
Signal name indication : Indicates the name of the srgnal selected in the Signal Select
dialog window.
Gamma, Differential 1,
Differential 2 and Off

select buttons :  When clicked the selected processing is applied.
To cancel, click Off.

Invert check box . Inverts the contrast of the scanning image. The box is shown
when the amplifier for the selected signal has a signal inversion
function.

Close button : Closes the dialog window.
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2.3.36 Signal Select Dialog Window (Standard and Full Screen Display Mode) -

The Signal Select dialog window is used for selecting an.image signal for display.
To open the dialog window, click the Signal Select button on the toolbar or select the Slgnal

Select command in the Setup menu.

Normal Mode list box................. Selects a signal used for scanning image display except for
e Split Screen mode.
Split Screen Mode_ list box ........ Selects signals for the Left and nght half areas in the Spllt
Screen mode.

Line Profile list box............. ...... Selects the signal to be used for the Line Analysis - mode.
It can be set independently of signals for Normal mode.
Background select buttons ......... Selects the background of the line profile in the Line Analysis

. mode. |[f Image is selected, the line profile is overlaid on the
- scanning image.  If Black is selected, only the line profile is
displayed.

Refer to. 3.11.3 Signal Selection and Color Mixing
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2.3.37 Signal Select (Color Mixing) Dialog Window (Dual Screen Display Mode)

The Signal Select dialog window is used for: selectlng image sngnals and for dlsplaymg an RGB

Color Mixed image.
To open the dialog window, click the Slgnal Select button i

the toolbar. : -
Selecting the Signal Select command in the Setup menu or the Color M|xmg command in the

Image menu can also open the dialog window.

i| or the Color Mixing button

Dual Screen Mode-A-Left

list DOX......coovviieeieee e . Selects the sngnal to be used for the (Left sude) scanmng image.

Dual Screen Mode-B-Right

list box.......... [P Selects the signal to be used for the (nght side) scanning
image.

Color Mixing check box and : ;
select buttons ......... errrrnn—————— Sets conditions for the RGB Color Mixing mode.
' To display a color composite image, assign the A or B signal
- for each of the three colors by clicking the select buttons, then
check the Color Mixing box to On. .
For example, A signal is SE and the B signal is BSE, and A is
assigned to Blue and B to both Red and Green.
A color composite image of yellow BSE and blue SE is then
“displayed.
. Toreturn to the B/W image display mode uncheck the Caolor
Mixing box. .

Refer to: 3.11.3 Signal Selection and Color Mixing .
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2.3.38 Simple Operation Toolbox : . - :

Frequently used function buttons are-placed on the toolbox. When you feel using buttons on
the toolbar is confusing, open this toolbox and close the toolbar You can op‘erate a|m'o'St all
- functions on this.toolbox. ECREE L i ERTRE ~
'Also it is useful when using the Full Screen mode upon closmg the tooIbar and controls on the
Scanning Image window.to extend image area: ' ' :
To open the toolbox, click the Simple Operation button
Operation command in the Operate menu.

-on the toolbar or seIect-the Simple

Applies high voltage to the electron gun’
and controls extracting voltage.
The name of the button is changedto -
SET when high voltage is applied, so
the emission current values can be
adjusted.

Displays accelerating voltage,
emission current.

Shuts down the high voltage.

Displays the operation mode for the
electron optical column.

Opens the HV Control
dialog window.

: SO ’ Opens the Column Setup
Opens the Image Setup ‘dialog window.
dialog window. e
_ O{p_ens the Stage Control
" dialog window.

Opens the Image Setup '
dlalog wmdow
‘ = , Opens the Photo Condition dialog
window.
The button is enabled when Direct
- Photo or Memory Photo is selected
o R * for Recording buttons.
Drives the stage to the
specimen exchange position.
The indicator above the button
turns green when the stage
reaches the specimen

exchange position. Closes this toolbox.
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Adjustmentarea = - ‘
- BIC button " Right button-click changes the button into | button for ABCC (Auto
. ... Brightness and Contrast adjustment) and {AA| button for BC Monitor
-mode. ' Left button click executes each furnction.
Referto: ~3.5.3 (1) Auto Adjustment (ABCC) -
3.5.3 (3) BC Monitor Mode

Focus button : Right button click changes the button into
and A\| button for Focus Monitor mode.

Left button click executes each function..

Refer to: 3.5.4 (2) Auto Focus Function
3.5.4 (6) Focus Monitor Mode -

| button for Auto Focusing,

Stig. button . Starts auto astigmatism correctlon ?
’ Referto: 3.5.4 (4) Auto Stigma Function
() Wobbl. button : Opens the Allgnment dralog wmdow and starts aperture alrgnment

(wobbler) mode.
Refer to: 3.4.2 (2) Aperture Alignment

Image Move area v s C e :
i1 putton : Enables Image Shift control by mouse operation. Click the button again
' - or right-click on the image to terminate Image Shift operation.

- Referto: 3.5.5.10 Operation of Electrical Image Shift

Runs or Stops scannmg alternately
Starts image capturrng ‘ '
Referto: 3.6. 4 Image Capturrng

| for Direct Photographing,
for Copy

Right button click changes the buttons into

" Printer an
frequently use.

| for PCI Transfer in order Select two buttons you most

Referto: 3.6.7 (3) Direct Photo Recording
- ... 3.6.7 (4) Memory Photo Recording
-.3.6.5 - Direct Save.
3.11.11 Print
3.11.10 Video Printer
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Functions area.......... Right button click changes the buttons into for Raster Rotation, -
for Signal Selection, for Data Entry, 4i¢ for CD Méasurement,
for Split/Dual Mag mod for Signal Processing
Pseudo-Color display an ‘ [{ for Data Display setup in order.
Select two buttons you most frequently use.

Refer to: 2.3.33 Raster Rotation Dialog Window
2.3.36 Signal Select Dialog Window
2.3.37 Signal Select (Color Mixing) Dialog Wlndow
2.3.22 Data Entry Toolbox
2.3.35 Signal Processing Dialog Window
2.3.32 Pseudo Color Dialog Window
2.3.21 Data Display Dialog Window

NOTE: Some buttons are disabled when these are not available ih,present screen mode or
mode of operation.

2.3.39 Split/Dual Mag Controller

Split Screen mode displays two images in the viewing area, and allows images to be displayed
for different signals and at different magnifications. The Split Sereen mode is available in
Standard Screen mode. To open this controller, click the Split Image button :[1}] on the toolbar
or select the Split DM command from the Scan menu. ' :

x1 button .................. Crenereean Image area is divided into two images with same magnification.
' Image signals for two images are independently selectable using

Signal Select dialog window.

xS button ... The area in the box cursor of the left side image is magnified 5
times and displayed on the right side area. The box cursor can be
moved by mouse dragglng

x10 button ...............ccoo The area in the box cursor of the left side i |mage is magnlfled 10
times and displayed on the right side area.  The box cursor can be
moved by mouse dragging. '

Off button.............ceevvvvvnnne Disables the Split Screen mode. »

Exit button........................... Disables the Split Screen mode and closes the controller.

B/C Control Left/Right....... Selects to which image signal the B/C control by mouse operation
is applied. Use this selection when different image signals are
assigned for the two images.

Refer to: 3.11.2 Split Screen and Dual Mag Mode

2-86
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2.3.40 Stage Control Dialog Window

The Stage Control dialog window is used to operate the specimen stage.

To open the dialog window, click the Stage Control button on the toolbar or chck the Stage
. on Stage area in Scanning Image window. Selecting the Stage Control
command from the Operate menu can also open the dialog window.

Go to Home button .... Drives the stage to the specimen exchange position.
The indicator above the button turns green when the stage reaches the
specimen exchange position. ‘

Restriction button...... Opens the Restriction dialog window to set the specimen holder and
traverse range in tilt (T) direction. Note that the Restriction button is
effective only when the stage is at the home position.

Speed slider............... Selects driving speed. The speed setting is effectlve for X Y dnve using
trackball operation.
Stop button ................ Stops stage motion. Use when you wish to stop s_tage while it is moving

by Go operation.
The following check boxes open control areas for each’ stége'axis and operation.
(1) X/Y/[Tilt Check Box |
Opens X/Y/Tilt area. U;é thesé cont"r‘o‘ls.kto oberate-“thek’ X, Y and Tilt (T) axes of the stage.

Referto: 3.5.5.6 X, Y Operation
3.5.5.7 Tilt Operation
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(2) Memory/Drive Check Box

Opens Stage Memory/Drive area. . Use this area to store stage coordinates-and to move
the stage to the previously stored positions.

"Refer to:  3.5.5.8 Position Memory Function

(3) Image Navigation Check Box
" Opens Image Navigation area. Use this area for the Image Navigation function.

Refer to: 3.5.5.9 Using Image Navigation Function .
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2.3.41 Toolbar Setting Dialog Window

You can select tool buttons placed on the toolbar. - The button arrangement is saved
independently for each login name. You can use your own toolbar when logged in with your
unique login name. S
To open this dialog window, select the Toolbar Setting command from the Option menu.

E Drata Manager
Wl Direct Save
'Print Setup
| Operating Conditioh:*
Copy Image

Copy Attribute
v Column SetUp

Alignment

Image SetUp™
v} Photo Condition

Tool button area.......... All available tool buttons-are listed here. -Check boxeé at the left of
button names to place and uncheck to remove the button.
Buttons for optional functions are selectable only whenthe functions are

installed.
Button Image ............ Indicates the button of the selected button name in the Tool button area.
Reset button............... Sets toolbar to default arrangement.
OK button................... Closes the dialog window.
Cancel button............. Cancels. lnput and closes the dlalog wmdow

NOTICE: ltis not possible to place all provided t_oolkbuttons on the. toolbar.' Choose only the
important buttons so they will not drop out at the right hand side of the toolbar.
The button arrangement is refreshed each time you change check/uncheck of boxes.
If you click the OK button while too many buttons are selected, a warmng message
. will be opened . . N L N i R
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2.3.42 Using Short-Cut Keys

Short-cut keys are available for execution of many commands.

(1)

()

Q)

(4)

Using Short-eut Keys

Input of Alt + [character which has underline in a main menu command] opens the pull-
down menu. And then, [character which has underline in a pull-down menu] executes the
command. For example, Alt + F opens the Flle menu and S key executes the Direct
Save command. :

While a pull-down menu is open, arrow keys Te)d (—+) select commands in order.

The Enter key executes the selected command.

Using Ctrl + ~ Keys er Functions Keys

Some frequently used commands are executed using. this type of short-cut keys.
They are; .

Ctrl + O: Open SEM Data Manager

Ctrl +S: Direct Save

Ctrl+ P: Print

Ctrl+ C: Copy Image

Ctri+L: Open Captured image window -

F1 . Help can be opened

F5 . . Runs or stops scanning alternately -

Use of Tab and Arrow Keys’

In an active window, the Tab key activates command buttons, selection boxes, input boxes
in order. When a selection box, where numeral values are to be chosen, selection buttons,
or slider controls are selected, these can be controlled using arrow keys.

Shift + Tab selects controls in reverse order." '

Selectlon of Alignment Operatlons

Using arrow keys, you can activate alignment functions in order. It is useful as alignment
operations are to be done in order of buttons, Beam Align to Low Mag Position.



